CCC(:: )Confer

PARTICIPANTS WINDOW

The Participants window provides you with an overview of what is happening within the session. It has
the following components:

Raise Hand and Emoticons column Polling Responses column

If Permissions column

Participants column ——
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Features

As a Moderator, you can use all the available Participant window features. Participants can use only a
subset of the features. In the table below, a checkmark indicates which functions can be performed by

Moderators and which can be performed by Participants.

Sort the Participants List

Feature Moderators Participants
Remove a Participant from the session v
Give or take away Moderator privileges v
Grant or take away a Participant’s permission to use a v
feature
Create and distribute Participants to various breakout v
rooms or return them all to the Main room
Allow Participants to send themselves to Breakout Rooms v
Send self to a Breakout Room v v
v v
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Reorder the columns in the Participants List
Save the Participants List
Print the Participants List

See who has joined the session and what permissions they
have

Select all the Whiteboard objects that were created by a
Participant

Request desktop control of a Participant’s desktop

See who is currently using a feature (activity lights)

See if any Participants are experiencing delays in
receiving the Whiteboard content. Audio. Application
Sharing or Video (status indicators)

Interact with others by entering and viewing polling
responses. using the emotion indicators and raising your
hand

View a user’s profile

When you join your CCC Confer session, you will see your name appear in the Participants List in
blue. All the Moderators in the session are displayed in alphabetical order at the top of the list followed

by all the Participants, who are also listed in alphabetical order.

This document describes how you can use the Participants window to assign permissions; sort the
Participants List; view what is going on in the session; create, send, and distribute Participants and
Moderators to breakout rooms; interact with Moderators and Participant; and view a user’s profile.
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Feature Permissions

All Participants will be granted the ability to click on an icon to raise/lower their hand, activate
emoticons, send polling responses and step away upon entry to the session.

In addition, when Participants first join the session, they will be configured with the following
permissions:

Permission Description
lcon

.‘ﬂ' A Participant has been granted permission to use the Audio feature —1.e.. talk in

the session.

A Participant has been granted permission to send Chat messages to anyone in the

Se551011.

If the permission 1s not granted. the Participant can still send Chat messages. but
only to Moderators.

A Participant has been granted permission to use the drawing tools on the

Whiteboard.

When this permission 1s granted, the Participant will see and be able to use the
drawing tools in the Whiteboard.

2 A Participant has been granted permission to transmit a video broadcast.

This column 1s visible only when a Moderator has enabled the video camera

support feature.
Menu command to enable video camera support:

Tools = Video = Enable Video Camera Support

A Moderator can withdraw the Participant permissions in the chart above at any time. To take
away a permission’

e For a specific Participant

o Click on the appropriate permission icon next to that Participant's name
e For all Participants

o Click on the appropriate permission icon in the column header
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1 When a Moderator disconnects from a session prior to the Participants, any permissions already
granted to the Participants will remain.

Assigning Feature Permissions

A Moderator can assign the Participant(s) permission for any of the features in the chart below at any
time. To assign a permission®

e For a specific Participant

o Click on the appropriate permission icon next to that Participant’s name
e For all Participants

o Click on the appropriate permission icon in the column header

In some cases, granting permission for a Participant to use a feature is a two-step process;
first you must get the permission column to appear in the Participants List and then grant the
individual Participants permission to use this feature.

Note: When a Moderator disconnects from a session prior to the Participants, any permissions already
granted to the Participants will remain.

The following table shows the permission icons and describes the permissions.

Permission Description
lcon
e A Participant has been granted permission to use the Audio feature —i.e., talk in
the session.
A Participant has been granted permission to send Chat messages to anyone in the
session.
If the permission is not granted, the Participant can still send Chat messages, but
only to Moderators.
y. A Participant has been granted permission to use the drawing tools on the
Whiteboard.
When this permission is granted. the Participant will see and be able to use the
drawing tools in the Whiteboard.
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- A Participant has been granted pernussion to host an Application Sharing session
or to control another user’s desktop.

i A Participant has been granted permussion to use the features in the Shared
Graphing Calculator (enter formulae, use the zoom feature, etc.).

This column 15 visible i the Participants List only when a Moderator has the
(Two-step | |Graphing Calculator window open.

process| Menu command to open the Graphing Calculator:
Window > Graphing Calculator
= A Participant has been granted pernussion to load files into the File Transfer
window.
This column 1s visible only when a Moderator has the File Transfer window open.
(TWO-SteP | |\ fonu command to open the File Transfer window:
process)
Window > File Transfer
e A Participant has been granted pernussion to transmit a video broadcast.
This column 15 visible only when a Moderator has enabled the video camera
support feature.
(Two-step Menu command to enable video camera support:
process)
Tools > Video > Enable Video Camera Support
EC] A Participant has been granted pernussion to enter text into the Closed-
Captioning window. (Participants can always read text in the Closed-Captioning
wimndow.)

This column 1s visible only when a Moderator has explicitly specified that it be

(Two-step | |30-
process)

Menu command to show the Closed-Captioning column:

Tools > Closed-Captioning > Show Status in Participants List
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Removing Feature Permissions

You can withdraw Participant permissions at any time. To take away a permission, click on the
appropriate permission icon next to the Participant’s name. To remove everyone’s permission
simultaneously, click the column header for that permission.

¢ If you disconnect from your session prior to your Participants, you may want to remove their
permissions to ensure that there is no unsupervised communications.

Preventing New Participant from Entering the Session

During your session, you are able to lock the session to prevent any new Participant from joining. If
any of the Participants that were in the session at the time you locked it are disconnected, they will still
be permitted to re-enter the session. If you lock the session and then remove a Participant from the
session, the banished Participant will not be able to join the session with the same username and
password until the session is unlocked.

By default the session will remain open for Participants to join at any time. To lock the session:
1. From the Tools menu, select Moderator.
2. Then de-select Allow New Participants to Enter the Session. You may change your selection at
any time.

Granting Participants the Moderator Privileges

You may give Moderator privileges to one or more of the Participants at anytime during your session
while still maintaining your own Moderator status.

1. Click on a single Participant’s name or highlight multiple Participants in the Participant List.
2. Right-click on the selected Participants to open the context menu and select Give Moderator
Privilege.
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The Give Moderator privilege dialog box appears.

Give Moderator Privilege f'E

| Areyou sure you wank ko give moderakor privileges ta the Follawing
\-\/ participants?

Charlie ”
Feicky
-
| tes [ Mo l

3. Click Yes to give the selected Participants the Moderator privilege.

The Participants receive a confirmation message indicating that they are now a Moderator. Once you

give a Participant Moderator privileges, they will have the same access during the session that you
have as the original Moderator.

If any Moderator exits or is disconnected from the session, then the remaining Moderators can
continue. The Moderator who was disconnected can rejoin the session at any time. If all the
Moderators exit or are disconnected, then the session is left without a Moderator. To re-establish a
Moderator, the original Moderator must re-connect to the session.

Take Away the Moderator Privileges

At any time, you can take away Moderator privileges from a Participant you (or another Moderator)
promoted earlier.

4. Click on a single Participant’s name or highlight multiple Participants in the Participants List.
5. Right-click on the selected Participants to open the context menu and select Take Away
Moderator Privileges
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When you remove the Moderator privilege from Participants, they will retain all the permissions you
had granted them before they became moderators.

Removing Participants
To remove one or more Participants from the session, in the Participants List:

1. Click on a single Participant’s name or highlight multiple Participants in the Participants List.
2. Right-click on the selected Participants to open the context menu and select Remove
Participant

The Remove Participant dialog box appears.

Remove participant @

9P

‘“"\r/ Are you sure you want to remove "Daniel™?

| Yes |’ Mo ]

3. Click Yes to remove the Participant(s) from the session.
The Participant is disconnected from the session immediately.

Participants can save or print the Whiteboard after being disconnected (provided you have not
protected the Whiteboard content). If you have locked the room, then the Participant will not be able to
reconnect. If the room has been left open, then the Participant may reconnect.

Knowing When Someone has Joined or Left a Session
There are four possible ways to tell if someone new has joined or left a session:

e The person’s name will appear in the Participant List when they join the session and will be
removed when they leave the session.
e An Audible Notification may be played when someone joins or leaves a session.?
e A Visual Notification may be displayed when someone joins a session.
e A message may be displayed in the Activity Window.

2 You can turn Audible and Visual Notifications off. For details, see Activity Window
document.
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Hand Raising/Lowering

Moderators and Participants can raise their hands at any time during the session. The Participants List
will indicate to the Moderator who has raised their hand and in what order.

&% Participants

Participants -
Vivian (Moderator...
Charlie
Ethel
Lucy (Profile)

Ricky

Click to raise your T ﬁ o
virtual hand \ ‘&i ; £ Hands Raised

> A

AR RN

| <

=
&

XS gususs

Participants
R . Bl Partidpants 1l
r # B ET (Moderator, Profile) -
1 42 » W Lauren (Me, Profie) B
w
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your virtual hand "& j f Hands Raised ;2 Wt

Stepping Away

The Step Away feature allows you to indicate to others in the session that you are temporarily
unavailable. Click on the Stepping Away icon as noted below.

@ Participants
& | v @ D _# Wl Participants 1l
&= # ® ET (Moderator, Profile) ~

£ o 7 W Lagren (Me, Profik)

b
Click to indicate Stepping Away
2 /
& % Participants J w* oy
¥ K [
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You are still connected to the session and can see and hear everything that is going on. Your name
will appear in italics and the text “Away” will appear in parentheses to indicate to everyone that you are
away from your computer.

Rejoining the Session

Click on the Rejoining the Session icon as noted below.

Participants

Participants
ET (Moderator, Profile)
Marip (dway, Me, Frofie)

i ) Click to indicate Rejoining the
i .
i';" 'ﬁ; Participants Session

Using the Emotion Indicators

Attendees can click on emotion indicators to provide feedback. When an indicator is selected,
everyone in the room will see the icon flash next to the person’s name for a short duration. The
following emotion icons are available:

leon Emotion Windows, Linux & Solaris |Mac Accelerator Keys
Accelerator Keys
I Laughter Ctrl+Alt+1 ~CH L
l@? Applause Ctrl+Alt+2 NHE 2
@D Confusion Ctrl+Alt+3 ~CH 3
£, Disapproval Ctrl+Alt+4 ~H4
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Activity Lights and Indicators

Activity Halo

When a Participant or Moderator is using a feature, a yellow halo appears behind the permission icon
next to their name. In the example at the right

Ethel is entering text in the Chat Panel; 4 Participants

Vivian is using the microphone (Audio)

Ricky has various permissions, but is Participants ¥ «PL 8 o
currently not using any features; Vivian (Moderator... & 8 _
A Breakout room was created by Vivian Lucy (Profile) £ a 0 s
Lucy is hosting and conftrolling an Ricky £ 2 -
Application Sharing session; and Private Room (1) @ “x #* & -
Charlie has the read-only Closed- |- charlie £ 2 -
Captioning window open. L Ethel * 8 -

Activity Indicators

In addition to the yellow halo, for Application Sharing, Closed Captioning and Audio there is additional
information about who is using the feature and in what capacity. (Refer to the document on our
website within the FEATURES tab for specific feature.)

Status Indicators

Status indicators appear in the Audio, Whiteboard, Application Sharing and Video permission columns
in the Participant List when data is being sent and received. For Audio, Video and Application Sharing,
the indicators signify a delay in the sending and/or receipt of data. For the Whiteboard, the indicators
tell Moderators who is receiving content.

The status indicators are dynamic and are updated and visible only to all Moderators throughout the
session. By keeping an eye on these indicators, you can adjust the pace of your session.
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In the Audio example to the right,
= the Moderator Vivian is talking,

L Participanks

Participants & v P 8 .-
* Lucy and Charlie are experiencing Vivian (Moderator... LaoW /A
del ] ine the Audio s 1 Charlie . L
clays in receiving the Audio signal, Ethel ey,
with Charlie lagging further behind, Lucy (Profile) FE LY.
and Ricky LW s
» Ricky and Ethel are not having any
problems receiving Audio.
Audio Setup Wizard Indicator
When someone in the session 1s using the
Audio Setup Wizard, their name will be i Periidpants
::lis.pla.yed in brlue.2 italics 31.1::1 the text Participants Il VL
“AudioSetup” will appear in parentheses Vivian (Moderator... LPaaB /A
after their name. In the example to the right, Charlie (AudtoSetup) fLa2oWy
Charlie 1s using the Audio Setup Wizard. = fLaswm/
Lucy (Profie) fLaeoly
Ricky £ 2 LN

Reordering the Participant s List Columns

Columns in the Participants List can be “reordered” by dragging and dropping the column headers to a
new location. The following is the default column order:

wu Participants

Participants ¥ <P IR/~
Vivian (Moderator... 2L oWy 4
Charlie s LWy
Lucy N w
Rickv o K™ .
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To move a column, grab the icon in its column header and drag it to the desired location. (In this
example the VolP microphone was moved from the column on the right of the WebCam column to the
column prior to the hand raising column.)

w Participants

Participants o ﬁ‘ Y N/~
Vivian (Moderator... < 2 o /A
Charlie f 2 -
Lucy £ 2 - g
Ricky A 'a &

The new column order will remain persistent from one session to the next (until you specify otherwise).
To return columns to the default order, select Restore Default Column Order from the sort option
menu:
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ws Participants

Sort option menu

# ‘Whiteboard - Main Room (Scaled

Participants L ¥ xg22B /> 4 <« B P 1/1 |Publicse
Vivian (Moderator... 4 2 4 Sort by Audio Mode
Charlie f 2 - s v Sort by Particpants
Lucy £ 2 W/ .
Ricky { s - / Sort by Raised Hands
Keep Me on Top
‘* ; Q’f Pamc.panu @ Eﬂ v Keep Moderators on Top
& v Keep Teleconference on Top
Keep Teleconference on Bottom
» Chat Keep Teleconference on Top When Muted
Show | All v Restore Default T

Polling Features

‘olumn Order

At any time during your session, you can poll the attendees\using five different polls. By default, the
Yes/No poll is available with the corresponding response buttons displayed below the participant list.
(See Polling document under the Features tab on our website for additional polling options.)
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